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1. About this manual

1.1. Copyrights
The information in this document is subject to change without notice and should not 
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for 
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or 
consequential damages of any nature or kind arising from the use of this document, 
nor shall ABB Oy be liable for incidental or consequential damages arising from use 
of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written 
permission from ABB Oy, and the contents thereof must not be imparted to a third 
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license 
and may be used, copied, or disclosed only in accordance with the terms of such 
license.

ABB Oy regularly provides standard training courses on its main products. The 
training program is available on the Internet at http://www.abb.com/
substationautomation. Contact your ABB contact for more information.

Copyright © 2005 ABB Oy 
All rights reserved.

1.2. Trademarks
ABB is a registered trademark of ABB Group. All other brand or product names 
mentioned in this document may be trademarks or registered trademarks of their 
respective holders.

1.3. General
The Protocol Mapping Tool (PMT) is used to create and edit the protocol mapping 
configuration, which is a cross-reference table between the application and the 
communication protocol. This table defines what information can be accessed from 
the device using the protocol interface. As REM 54_, REF 54_, RET 54_, REC 52_ 
and REX 52_ terminals are programmable devices which may run various 
application setups (different sets of function blocks), the mapping is also 
reconfigurable.

The mapping can contain a lot of information the device needs, but which is not 
necessarily important for viewing and changing from the configuration engineering 
point of view. Therefore, the mapping will be presented as a list of accessible 
protocol points instead of a spreadsheet-like table with all the rows and all the 
attributes.

The Protocol Mapping Tool uses the relay configuration project to create a mapping 
for a given application. After a mapping has been created, the user can modify it by 
removing or adding points, changing their order and creating protocol compositions, 
such as user-defined registers (bit-field and analog) or control structures.
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The whole process of creating the communication interface configuration is 
presented in Fig. 1.3.-1.

comm_interface_b

Fig. 1.3.-1 Flow of information during a communication interface creation

1.4. Using this manual
This manual describes the functionality of the Protocol Mapping Tool.

Chapter 2. General describes general application concepts such as Protocol Mapping 
Tool Wizard, Protocol Mapping Tool and the working modes.

Chapter 3. Quick start reference contains a step-by-step description on how to create 
a protocol mapping and how to activate an add-on protocol for a relay.

Chapter 4. Working with the Protocol Mapping Tool presents the Protocol Mapping 
Tool and the interface elements, and their functions.
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Chapter 5. Modbus, Chapter 6. DNP 3.0 and Chapter 7. IEC 60870-5-101 provide a 
detailed description of the Protocol Mapping Tool features supporting the given 
protocol.

Chapter 8. Troubleshooting contains frequently asked questions and their answers.

1.5. Use of symbols
This publication includes warning, caution, and information icons that point out 
safety related conditions or other important information. It also includes tip icons to 
point out useful information to the reader. The corresponding icons should be 
interpreted as follows:

Although warning hazards are related to personal injury, and caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
comply fully with all warning and caution notices.

1.6. Terminology

The caution icon indicates important information or warning related 
to the concept discussed in the text. It might indicate the presence of 
a hazard which could result in corruption of software or damage to 
equipment or property.

The information icon alerts the reader to relevant facts and 
conditions.

The tip icon indicates advice on, for example, how to design your 
project or how to use a certain function.

Add-on protocol Optional communication protocol, which can be configured and 
activated separately. Add-on protocols are supported by certain 
REM 54_, REF 54_ and RET 54_ terminals.

DNP 3.0 Distributed Network Protocol.
The communication protocol defined by Harris Controls based on 
the early versions of the IEC 870-5 specifications.

IEC 60870-5-101 and 
IEC 60870-5-103

International Standard IEC 60870-5-101 and IEC 60870-5-103, 
communication protocols that has been prepared by the IEC 
Technical Committee 57: Power system control and associated 
communications.

Modbus Modbus communication protocol is a messaging structure 
developed by Modicon in 1979, used to establish master-slave/
client-server communication between intelligent devices.

Pattern Function block specific resource file describing what kind of data 
and how the data of a function block is mapped for a protocol.
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1.7. Abbreviations

1.8. Related documents

1.9. Document revisions

ASDU Application Service Data Unit
LON Local Operating Network,

communication protocol developed by Echelon
PMT Protocol Mapping Tool
SPA Data communication protocol developed by ABB

Name of the manual Document ID
CAP 505 User�s Guide 1MRS752292-MUM
IEC 60870-5-101 Remote Communication Protocol for 
REC 523, Technical Description

1MRS750956-MUM

LIB, CAP and SMS, Tools for Relays and Terminals, 
User's Guide

1MRS752008-MUM

Version Date History
A 14.04.2004 Document created
B 30.06.2004 REX 521 support added
C 20.12.2004 RET 54_ additions
D 01.03.2005 IEC 60870-5-101 protocol,

REC 52_ additions
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2. General

The Protocol Mapping Tool is used for creating and editing the protocol mapping 
configuration. It supports the editing of mappings for the following terminals and 
protocols:

� REM 54_ 
� Modbus

� REF 54_
� DNP 3.0
� Modbus

� RET 54_
� DNP 3.0
� Modbus

� REX 52_
� DNP 3.0

� REC 52_
� IEC 60870-5-101

2.1. Protocol Mapping Tool Wizard
The Protocol Mapping Tool Wizard enables a quick start to create a mapping. The 
Wizard starts automatically when the Protocol Mapping Tool is started from the 
CAP 505's Project Structure Navigator window. The Protocol Mapping Tool Wizard 
can be called any time, provided that the Create New Mapping option is selected in 
the main menu or toolbar.

The Wizard guides the user through:

� Creating a new mapping
� Opening an existing mapping
� Importing a mapping
� Deleting a mapping

The Protocol Mapping Tool gets most of the necessary information directly from the 
CAP 505 project, i.e. the relay application the user has been working on and the 
selected add-on protocol.

The Protocol Mapping Tool Wizard is described in detail in Section 4.1. Protocol 
Mapping Tool Wizard.

2.2. Protocol Mapping Tool
The editing features of the Protocol Mapping Tool are available when the user 
proceeds through all the steps of the Wizard and the Protocol Mapping Tool is 
shown. 

The Protocol Mapping Tool is able to:

� Add new points to a mapping
� Remove points from a mapping
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� Change the addresses and the order of points within a whole data category
� Change the conversion factors of analog points
� Add predefined structures to a mapping
� Manage event definitions mapped as points within mapping
� Export mapping information into HTML or text documents

The Protocol Mapping Tool provides certain features available exclusively for a 
selected protocol and/or terminal, e.g. an unsolicited reporting disabling and 
enabling provided for DNP 3.0 dependent mappings. 

The Protocol Mapping Tool is described in detail in Section 4.2. Protocol Mapping 
Tool.

2.2.1. Working modes 
The Protocol Mapping Tool provides working modes to force some limitations 
during mapping editing. The Protocol Mapping Tool supports the following 
working modes:

Basic (default mode)
In the basic mode the user is allowed to modify only existing points. It is not possible 
to add or remove points within a mapping. The total number of points and their types 
is fixed. 

The following features are available when editing a mapping:

DNP 3.0

� Conversion factor editing
� Class assignment 
� Unsolicited reporting flags enabling/disabling 

Modbus

� Conversion factor editing

The basic working mode is useful when the user needs to only slightly change  
settings in a mapping.

IEC 60870-5-101

� Conversion factor editing
� General interrogation assignment
� Measurement value format change
� Data class (priority) assignment

Advanced
In the advanced mode the user can execute all the available editing features (i.e. 
adding points). 

Entering the advanced mode is not restricted, since the purpose of the two different 
modes only is to minimize unwanted changes.

All the editing features are described in detail in Section 4.2.3.3. Mapping editing
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3. Quick start reference

This chapter contains a step-by-step description on how to create a protocol mapping 
and how to activate a protocol for a relay. For details on how to add and configure 
relay objects in general in CAP 505, refer to the User�s Guide, the Tools for Relays 
and Terminals manual and the Relay Configuration Tool manuals of CAP 505 
(information can be found in Section 1.8. Related documents).

3.1. Configuring a relay object for REF 54_, REM 54_ and RET 54_
The Protocol Mapping Tool is an object tool in CAP 505. However, it is not 
available by default in the Project Structure Navigator for a newly created relay 
object, and is generally available only for certain relay types and revisions.

To be able to use the Protocol Mapping Tool, the relay object has to be configured 
so that the selected SW configuration (SW library and its revision) supports one or 
more add-on protocols. During the configuration, the support availability of the add-
on protocol can be seen from the "Add-on protocol" list contents (see Fig. 3.1.-1).

As an example, a REF 543 relay and Modbus protocol is used here. The figures are 
captured from the current versions of the related tools, so they are only to be 
regarded as samples.

config_ref

Fig. 3.1.-1 Configuring the REF 54_ relay object

Depending on the need, the appropriate add-on protocol has to be selected from the 
list, as well as a proper "Apl configuration" (relay application).
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After the selections have been accepted, the Protocol Mapping Tool will appear on 
the Object Tools list (see Fig. 3.1.-2). However, if the Protocol Mapping Tool is still 
not visible in the project tree, the selections in the configuration dialog must be 
checked.

ref_object_tools

Fig. 3.1.-2 REF 54_ Object Tools list

3.1.1. Configuring a relay application
The protocol mapping is based on the relay application (relay configuration). If the 
"Apl configuration" selection made in the configuration dialog (see Fig. 3.1.-1) is 
not adequate, the Relay Configuration Tool must be used to create or modify the 
relay application.

If the Relay Configuration Tool is used to modify the application, it is important to 
remember to compile the application when it is ready. Only by doing this, the related 
description files are updated.

If function blocks are added to or removed from the application 
later, the protocol mapping must be changed accordingly or created 
again.
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3.2. Configuring a relay object for REX 52_
The Protocol Mapping Tool is an object tool in CAP 505. However, it is not 
available by default in the Project Structure Navigator for the newly created REX 
52_ relay objects, and is generally available only for certain relay configurations.

To be able to use the Protocol Mapping Tool, the relay object has to be configured 
so that both the Hardware library and Standard configuration revisions are "E" or 
later (see Fig. 3.2.-1). The Protocol Mapping Tool supports only the DNP 3.0 
protocol, when using REX 52_ type relays.

config_rex

Fig. 3.2.-1 Configuring the REX 52_ relay object

After the selections have been accepted, the Protocol Mapping Tool will be 
displayed on the Object Tools list (see Fig. 3.2.-2). If the Protocol Mapping Tool is 
not visible on the list, check that Hardware library is Rev. E or later in the attributes 
settings (see Fig. 3.2.-1).
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rex_object_tools

Fig. 3.2.-2 REX 52_ Object Tools list

3.3. Configuring a relay object for REC 52_
The Protocol Mapping Tool is an object tool in CAP 505. However, it is not 
available by default in the Project Structure Navigator for the newly created 
REC 52_ relay objects, and it is generally available only for certain relay 
configurations.

To be able to use the Protocol Mapping Tool, the relay object has to be configured 
so that the SW library is REC523-1MRS118517 and the revision is F or later (see 
Fig. 3.3.-1). The Protocol Mapping Tool supports only the IEC 60870-5-101 
protocol, when using the REC 52_ type relays.
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config_REC52_

Fig. 3.3.-1 Configuring the REC 52_ relay object

After the selection has been accepted, the Protocol Mapping Tool is displayed on the 
Object Tools list (see Fig. 3.3.-2). If the Protocol Mapping Tool is not visible on the 
list, check that the SW library is REC523-1MRS118517 and the revision is F or later 
in the attributes settings (see Fig. 3.3.-1).

object_REC52_

Fig. 3.3.-2 REC 52_ Object Tools list
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3.3.1. Configuring a relay application
The protocol mapping is based on the relay application (relay configuration). If the 
"Apl configuration" selection made in the configuration dialog (see Fig. 3.3.-1) is 
not adequate, the Relay Configuration Tool must be used to create or modify the 
relay application.

If the Relay Configuration Tool is used to modify the application, it is important to 
remember to compile the application when it is ready. Only by doing this, the related 
description files are updated.

3.4. Creating protocol mapping
The mapping must be created and downloaded for REF 54_, REM 54_ and 
RET 54_. The default mapping already exists in REX 52_ and in REC 52_.

3.4.1. Opening Protocol Mapping Tool
The Protocol Mapping Tool is opened by double-clicking its name from the object 
tool list. 

1. If no add-on protocol was selected during the relay object configuration, the tool 
cannot be opened.

pmt_notification_1

Fig. 3.4.1.-1 Message shown during startup of the Protocol Mapping Tool, when 
no add-on protocol has been selected.

2. If the selected add-on protocol is IEC 60870-5-103, the mapping is fixed in the 
relay, and it needs not to be mapped by the Protocol Mapping Tool.

If function blocks are added to or removed from the application 
later, the protocol mapping must be changed accordingly or created 
again.

It is not possible to add more points to the default mapping. The 
available points are defined by the Protocol Mapping Tool.

With REF 54_, REM 54_ and RET 54_ there are two cases, where 
the opening might be prevented (see Fig. 3.4.1.-1 and Fig. 3.4.1.-2).
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pmt_notification_2

Fig. 3.4.1.-2 Message shown during startup of the Protocol Mapping Tool, when 
the add-on protocol selected does not need to be mapped by the 
tool.

3.4.2. Creating new protocol mapping
When the Protocol Mapping Tool is opened, the wizard dialog will always be shown 
first (see Fig. 3.4.2.-1).

pmt_wizard

Fig. 3.4.2.-1 Creating a new protocol mapping with the Protocol Mapping Tool 
wizard.

The fastest way to create a protocol mapping is to select Create New Mapping from 
the wizard dialog and accept the default values provided by the wizard until the 
Protocol Mapping Tool dialog is opened. Then, if the default mapping is accepted, 
the mapping is ready to be saved. Otherwise, the editing features of the tool can be 
utilized.
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3.4.3. Exporting mapping data
When the protocol mapping is ready from the relay point of view, it is recommended 
to export the mapping data to a file. This export file can then be used as a reference 
when configuring the protocol master system (see Fig. 3.4.3.-1).

pmt_export

Fig. 3.4.3.-1 Functions to export protocol mapping data for master system 
configuration.

3.4.4. Saving protocol mapping file
Before exiting the Protocol Mapping Tool, the created mapping must be saved. The 
default mapping file name can be accepted or another name given (see Fig. 3.4.4.-1).
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save_file

Fig. 3.4.4.-1 Saving a protocol mapping file

It is very important to check that the option "Save binary file" has 
been set. Otherwise, the actual mapping file to be sent to the relay is 
not created.
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3.5. Downloading protocol mapping to REF 54_, REM 54_ and 
RET 54_ 

Rdt_send_b

Fig. 3.5.-1 Downloading protocol mapping file to a REF 54_ relay

� Downloading the relay configuration inactivates the add-on protocol and deletes 
the protocol mapping. Therefore, also the protocol mapping must be sent again, if 
the relay configuration is sent.

� Due to the above, the protocol mapping must be received from the relay before 
downloading the relay configuration, if the protocol mapping file is not available 
elsewhere. The "RCT Project" does not include the protocol mapping file.

� The protocol mapping file can also be downloaded separately, if the active add-on 
protocol in the relay is the same as the one being downloaded.

� The protocol mapping file for the IEC 60870-5-103 protocol is never used; it 
does not need to be downloaded and cannot be uploaded. Downloading this 
protocol only activates the protocol in the relay.

The following should be noticed when downloading a protocol 
mapping file:

After downloading the protocol mapping, the Store and Reset 
functions must be performed to activate the add-on protocol.
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3.5.1. Setting add-on protocol related parameters
If the object configuration has been made correctly, the Relay Setting Tool includes 
the parameter page for the selected add-on protocol. If the parameters are not visible, 
the relay object configuration must be checked and the relay applications compiled 
again in the Relay Configuration Tool (see Fig. 3.5.1).

rst_parameters

Fig. 3.5.1.-1 Setting add-on protocol related parameters for REF 54_

REM 54_ units do not yet support the setting of add-on protocol 
parameters using the Relay Setting Tool. The parameters have to be 
set locally.

After setting and downloading the parameters, the Store function 
must be performed to store the parameters to the non-volatile 
memory of the relay.
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3.5.2. Uploading protocol mapping from REF 54_, REM 54_ and 
RET 54_
It is possible to upload the protocol mapping file from REF 54_, REM 54_ and 
RET 54_. This is useful if the mapping in the relay has been modified or is unknown. 
For more information, see Section 4.2.3.1. Opening of an existing mapping. 

Rtd_receive_b

Fig. 3.5.2.-1 Uploading protocol mapping file from REF 54_

3.6. Downloading protocol mapping to REX 52_

rdt_send_rex

Fig. 3.6.-1 Downloading protocol mapping file to a REX 52_ relay

It is not possible to upload a mapping from an empty relay. 
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The downloaded protocol mapping is taken into use immediately after a successful 
mapping transfer and when the relay has been switched back to the protection mode. 

3.6.1. Setting protocol related parameters
The protocol specific communication parameters are configured in the Relay Setting 
Tool. When the settings are done, they are sent to the relay.

rst_parameters_rex

Fig. 3.6.1.-1 Setting protocol related parameters for REX 52_

When downloading a new protocol mapping file to the relay, the 
relay is switched from the protection mode to the configuration 
mode. During this sending process all the protection functions are 
disabled until the relay is set back to the protection mode.

Sending the protocol mapping file to REX 52_ is possible only with 
the SPA protocol via the optical front panel connector. Rear 
connectors (SPA or LON) are not supported for downloading. 
However, receiving the protocol mapping from REX 52_ is possible 
also via the rear connections.
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3.6.2. Uploading protocol mapping from REX 52_
It is also possible to upload the protocol mapping file from the REX 52_. This is 
useful if the mapping in the relay has been modified and is unknown. For more 
information, see Section 4.2.3.1. Opening of an existing mapping.

rdt_receive_rex

Fig. 3.6.2.-1 Uploading protocol mapping file from REX 52_

3.7. Downloading protocol mapping to REC 52_

rdt_send_rec

Fig. 3.7.-1 Downloading protocol mapping file to a REC 52_ relay
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The protocol mapping file for IEC 60870-5-101 can be downloaded either separately 
or together with the configuration. Downloading of the relay configuration does not 
affect the existing protocol mapping in REC 52_.

3.7.1. Setting protocol related parameters
The protocol specific communication parameters are configured in the Relay Setting 
Tool (see Fig. 3.7.1.-1). When the settings are done, they are sent to the relay.

For more information on protocol specific communication parameters, see the 
Technical Description for IEC 60870-5-101 (information can be found in Section 
1.8. Related documents).

rst_parameters_rec

Fig. 3.7.1.-1 Setting protocol related parameters for REC 52_

After downloading the protocol mapping, the Store and Reset 
functions must be performed to activate the changes.

After setting and downloading the parameters, the Store function 
must be performed to store the parameters to the non-volatile 
memory of the relay.
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3.7.2. Uploading protocol mapping from REC 52_
It is possible to upload the protocol mapping file from REC 52_. This is useful if the 
mapping in the relay has been modified or is unknown. For more information, see 
Section 4.2.3.1. Opening of an existing mapping. 

rdt_receive_rec

Fig. 3.7.2.-1 Uploading protocol mapping file from REC 52_

Also a not configured REC 52_ contains a default mapping.
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4. Working with the Protocol Mapping Tool

This chapter presents the user interfaces and editing features of the Protocol 
Mapping Tool.

4.1. Protocol Mapping Tool Wizard
Fig. 4.1.-1 shows the user interface of the Protocol Mapping Tool Wizard. The user 
can decide whether to create a new mapping, open an existing one or import a 
mapping from a different relay object. It is also possible to delete no longer needed 
mappings.

wizard

Fig. 4.1.-1 Protocol Mapping Tool Wizard

The Wizard consists of the following elements:

� Caption bar
� Menu bar
� Processing context
� Function buttons
� Navigation buttons

Caption bar
The caption bar contains the full name of the Protocol Mapping Tool.

Menu bar
The menu bar provides access to the Help menu. The content of this menu is 
presented in Section 4.2.1.4. Help menu
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Processing context
The processing context presents basic information describing the edited mapping 
and contains:

� The application name (i.e. relay object title) with the related device name and its 
revision

� The protocol name

Function buttons
The function buttons allow the user to choose the operation to be performed. 
Available operations are described in detail in Section 4.1.1. Creating a new 
mapping - Section 4.1.4. Deleting mapping

Navigation buttons
Navigation buttons allow the user to move between the steps in the Wizard.

� The Exit button quits the Protocol Mapping Tool

Note: If the Wizard is started from the Protocol Mapping Tool, Exit is replaced by 
Cancel button, which quits the Wizard and returns to the Protocol Mapping Tool.

� The Next/Finish button moves to the next Wizard step or switches to the Protocol 
Mapping Tool

� The Back button moves to the previous Wizard step

4.1.1. Creating a new mapping
By selecting this feature, the user can create a new mapping. 

The creation of a new mapping is always supervised by the Protocol Mapping Tool 
Wizard dialog. If a mapping was changed but not saved, the Protocol Mapping Tool 
shows a message box that prompts the user to save.

Advance in the Wizard by clicking the Next and Finish buttons. 

More information on the mapping creation process can be found in Section 5.1.1. 
Creating a new mapping for Modbus and in Section 6.1.1. Creating a new mapping 
for DNP 3.0 and in Section 7.1.1. Creating a new mapping for IEC 60870-5-101.

Selected addresses can be changed later during the editing, this is described in 
Section 6.5. Mapping editing features (DNP) and in Section 7.4. Mapping editing 
features (IEC 60870-5-101).

Overlapping-check is performed for the Modbus and IEC 60870-5-101 protocols. 
This is described in Section 5.4. Complex structures (Modbus) and in Section 7.4. 
Mapping editing features (IEC 60870-5-101).
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4.1.2. Opening an existing mapping
To open an existing mapping, select the mapping file and click the Finish button (see 
Fig. 4.1.2.-1). The Protocol Mapping Tool will open with its content.

Opening a mapping is described in detail in Section 4.2.1.3. Settings menu.

wizard_opn

Fig. 4.1.2.-1 Opening an existing mapping
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4.1.3. Importing a mapping 
It is possible to import a mapping from a different relay object. It only requires 
browsing the CAP project�s tree structure and choosing the desired file. If the source 
and destination objects have the same target terminals (revisions may be different) 
importing is possible (see Fig. 4.1.3.-1). 

To import an existing mapping, select the mapping file and click the Import button 
the Protocol Mapping Tool will open with its content.

wizard_imp

Fig. 4.1.3.-1 Importing a mapping

Dealing with unsupported points
It is possible that some function blocks and their protocol points are not supported 
by the destination project. In this case it is required to choose how to treat the 
unsupported points (see Fig. 4.1.3.-2).

� If the user wants to keep the addressing from an already prepared mapping, non-
existing points can be replaced by so called �dummy points� with the value 0.

� If the efficiency of data transfer is more important, unsupported points should be 
removed and the mapping readdressed.



1MRS755277 CAP 505

33

 
Protocol Mapping Tool
Operation Manual

wizard_imp2

Fig. 4.1.3.-2 Choosing how to treat unsupported points

4.1.4. Deleting mapping
Delete Mapping removes selected mapping files from the relay object. This option 
can be used to clean up possible unnecessary mapping files created during the 
engineering phase.

This operation is irreversible and thus the mapping deletion is limited. The following 
files cannot be removed:

� Binary mapping files
� Mapping files having associated binary mapping file
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4.2. Protocol Mapping Tool
Fig. 4.2.-1 shows the user interface of the Protocol Mapping Tool during mapping 
editing.

look_REM_desc

Fig. 4.2.-1 Protocol Mapping Tool

The main dialog is composed of the following elements:

� Caption bar
� Menu bar
� Tool bar
� Mapping tree
� Status bar
� Pop-up menu

All the listed pieces of the user interface are briefly described below. The mapping 
tree is described in detail in Section 5.2. Mapping tree for Modbus, in Section 6.2. 
Mapping tree for DNP 3.0 and in Section 7.2. Mapping tree for IEC 60870-5-101. 
The menu bar and the toolbar are described in Section 4.2.1. Description of menu 
items and toolbar buttons and the pop-up menu in Section 4.2.2. Description of the 
pop-up menus.

Caption bar
The caption bar contains the full name of the Protocol Mapping Tool followed by 
the names of the selected add-on protocol and of the edited mapping file (see 
Fig. 4.2.-1). 

If the name of the mapping file has not already been set, the word "Untitled" will be 
shown instead.

If the edited mapping has been changed but not yet saved, the mapping file name 
will be followed by an asterisk (*).
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Menu bar
The menu bar provides access to the File, Edit, Settings and Help menus. The 
contents of the listed menus are described in Section 4.2.1. Description of menu 
items and toolbar buttons

Toolbar
The toolbar provides fast access to most of the Menu bar functions. A description 
and instructions on how to use of the buttons are provided in Section 4.2.1. 
Description of menu items and toolbar buttons.

Mapping tree
The mapping tree is the main area of the Protocol Mapping Tool. The mapping tree 
provides a tree structure, which presents points stored within a mapping as leaves in 
a tree. This is described in greater detail in Section 5.2. Mapping tree for Modbus, 
in Section 6.2. Mapping tree for DNP 3.0 and in Section 7.2. Mapping tree for IEC 
60870-5-101.

Pop-up menu
The pop-up menu is available in the area of the mapping tree. It provides the most 
common editing operations of points currently selected within the mapping tree.

Details concerning the pop-up menu are available in Section 4.2.2. Description of 
the pop-up menus.

Status bar
The status bar presents the basic information of the mapping (see Fig. 4.2.-2).

status_bar_REM

Fig. 4.2.-2 Status bar of Protocol Mapping Tool

The status bar contains five fields:

1. Device name (related to the selected project)
2. Selected application name (relay object title)
3. Selected working mode
4. Modification indicator showing the word �MOD�, when the mapping has been 

changed but not saved
5. Number/percentage of occupied rows

4.2.1. Description of menu items and toolbar buttons
The toolbar and the menus are not the same in both working modes. Some menu 
options and toolbar buttons are visible in both modes, whereas other options and 
toolbar buttons are disabled in the basic mode because of the mode restrictions. 
There are four user interface menus in the Protocol Mapping Tool. The menus will 
all be presented in the following sections.
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4.2.1.1. File menu
Fig. 4.2.1.1.-1 shows the Protocol Mapping Tool's File menu. The different menu 
functions are explained below.

menu_file

Fig. 4.2.1.1.-1 The File menu in the Protocol Mapping Tool

Create New Mapping
By selecting this item in the menu, the user can create a new mapping. This feature 
is described in Section 4.2.2.5. Selecting address format (Hex/Decimal Points) 
under Creating a new mapping.

Open Mapping File�
This option allows the opening of an existing mapping stored within a project 
directory. Details concerning the opening of an existing mapping are available in 
Section 4.2.3.1. Mapping management under Opening of an existing mapping.

Save Mapping File�
Mapping and its binary representation can be stored in the CAP 505 project directory 
by using the Save Mapping File� menu item. A more detailed description of the 
saving operation is found in Section 4.2.3.1. Mapping management under Saving an 
edited mapping.

Export Document File...
This option is used for documentation purposes and it allows the user to export 
complete information concerning the currently edited mapping. This feature is 
described in detail in Section 4.2.3.2. Mapping export.

Export Conversion File...
This option is intended to be used for importing data to master systems. It allows the 
user to export complete information concerning points maintained by the edited 
mapping. This feature is described in detail in Section 4.2.3.2. Mapping export.

Exit
This function exits the program. The program asks whether the user wants to save 
unsaved changes or not before exiting.
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4.2.1.2. Edit menu
Fig. 4.2.1.2.-1 shows the components of the Edit menu for Modbus mapping, 
Fig. 4.2.1.2.-2 for DNP 3.0 mapping and Fig. 4.2.1.2.-3 for IEC 60870-5-101 
mapping. Part of the menu is generic and part is protocol specific. The protocol 
specific parts are described in the Modbus, DNP 3.0 and IEC 60870-5-101 specific 
parts of the manual.

menu_edit_rem

Fig. 4.2.1.2.-1 The Edit menu for Modbus mapping (in the Advanced mode)

menu_edit_dnp

Fig. 4.2.1.2.-2 The Edit menu for DNP 3.0 mapping (in the Advanced mode)
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menu_edit_IEC101

Fig. 4.2.1.2.-3 The Edit menu for IEC 60870-5-101 mapping (in the Advanced 
mode)

Add Points

This menu item allows the user to add new points into an edited mapping. More 
information concerning the adding of points is available in Section 4.2.3.3. Mapping 
editing under Adding new points.

Toolbar button:

plus

Keyboard shortcut: <Ins>

Delete Points

The option is for removing of points existing in an edited mapping. More 
information can be found in Section 4.2.3.3. Mapping editing under Removing 
existing points.

Toolbar button:

minus

Keyboard shortcut: <Del>

This option is available in the advanced mode.

This option is available in the advanced mode.
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Change Base Address

This menu item allows the user to change the base address of the selected data 
category. More information can be found in Section 5.4. Complex structures under 
Base address editing.

Change Conversion Factor
This menu option is used to edit conversion factors of selected analog registers. See 
Section 4.2.3.5. Conversion factor editing for more details.

Cut Points

This menu item provides the way to select some points in a mapping in order to paste 
them into a different location. Cut Points is presented in Section 4.2.3.3. Mapping 
editing under Cut and paste operations.

Toolbar button: 

sciz

Keyboard shortcut: <Ctrl>+<X>

Paste Points

The Paste Points function is available for performing the pasting of points into a 
different location. Details are available in Section 4.2.3.3. Mapping editing under 
the heading Cut and paste operations.

Toolbar button: 

paste

Keyboard shortcut: <Ctrl>+<V>

This option is available in the advanced mode.

This option is available in the advanced mode.

This option is available in the advanced mode.
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Verify Against Patterns

Patterns are function block specific resource files used by PMT. They describe what 
kind of data and how the data of a function block is mapped for a protocol.

This option compares the mapping content with patterns and allows fixing all the 
detected errors and problems. More information can be found in Section 4.2.3.4. 
Verification against patterns.

Keyboard shortcut: <Ctrl>+<A>

4.2.1.3. Settings menu
The Settings menu of the Protocol Mapping Tool is presented in Fig. 4.2.1.3.-1 
(Modbus) and in Fig. 4.2.1.3.-2 (DNP 3.0 and IEC 60870-5-101). Check Duplicates 
Before User Register Added is available only when Modbus is used.

menu_settings_rem

Fig. 4.2.1.3.-1 The Settings menu of Modbus

menu_settings_dnp

Fig. 4.2.1.3.-2 The Settings menu of DNP 3.0 and IEC 60870-5-101

Check Duplicates Before User Register Added
This menu toggle enables/disables the scan for duplicate entries within user-defined 
registers. Section 5.4. Complex structures under User Registers (User-Defined 
Registers) describes how this setting is used.

Warn Before Item Deleted
This menu toggle enables/disables the warning shown each time the user tries to 
remove any register from a mapping tree. See Section 4.2.3.3. Mapping editing 
under Removing existing points for more details on how to use the setting.

Working Mode submenu
Fig. 4.2.1.3.-3 depicts the Working Mode submenu:

This option is available in the advanced mode.
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menu_settings_mode

Fig. 4.2.1.3.-3 The Working Mode submenu

The Working mode submenu is composed of two menu toggles, Basic and 
Advanced, which are used to switch the Protocol Mapping Tool between the basic 
and the advanced working mode.

The basic and advanced modes are described in Section 2.2.1. Working modes.

Conversion File Address Format submenu
Fig. 4.2.1.3.-4 depicts the Conversion File Address Format submenu:

menu_settings_address

Fig. 4.2.1.3.-4 The Conversion File Address Format submenu

The Conversion File Address Format submenu is composed of two menu toggles, 
Descriptive and SCADA, which are used to switch the address format used during 
exporting the binary point information into the conversion file.

� Descriptive address format is composed of a category identifier and a point 
address within the category (in case of Modbus, the subcategory identifier 
bounded by round brackets is also provided).

Table 4.2.1.3-1 and Table 4.2.1.3-2 show examples of descriptive and SCADA 
address formats.

Table 4.2.1.3-1 Example of a descriptive address format:

Note! All descriptive addresses are zero-based counters.

� SCADA address format is composed of a category identifier and a point address 
within the category. In case of binary categories, all the addresses are grouped 
within 16-bit registers.

Protocol Signal type Address (visible in mapping tree) Descriptive address
Modbus Binary Binary signal CO PDB 00139 - coil no. 139 

defined in process data basic range
CO 00138 (PDB)

Analog HR PDE 00035 - holding register no. 35 defined 
in process data extended range

HR 00034 (PDE)

DNP 3.0 Binary BI 00139 - binary input no. 140 BI 00139
Analog AO 00035 - analog output no. 36 AO 00035

IEC 60870-5-101 Binary M_SP 00141 M_SP 00141
Analog M_ME 00035 M_ME 00035
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Table 4.2.1.3-2 Example of a SCADA address format:

Note! All SCADA register numbers and bit numbers are zero-based counters.

4.2.1.4. Help menu

menu_help

Fig. 4.2.1.4.-1 The Help menu

Contents and Index
Both menu options are used to browse the Help menu's content.

Keyboard shortcut: <F1>

About
The About dialog contains the versions of the Protocol Mapping Tool and the pattern 
library supported by the tool. 

4.2.2. Description of the pop-up menus
This section describes the pop-up menus available for the mapping tree in the 
Protocol Mapping Tool.

Fig. 4.2.2.-1 shows the components of the pop-up menu shown for the Modbus 
mapping tree in the main window:

menu_popup_ref

Fig. 4.2.2.-1 Pop-up menu for Modbus mapping

Protocol Signal type Address (visible in mapping tree) SCADA address
Modbus Binary CO PDB 00139 [139 = (8*16)+11] CO 00008^10 

Analog HR PDE 00035 - holding register no. 35 
defined in process data extended range

HR 00034

DNP 3.0 Binary BI 00139 BI 00008^11
Analog AO 00035 AO 00035

IEC 60870-5-101 Binary M_SP 00141 M_SP 00008^12
Analog M_ME 00035 M_ME 00035



1MRS755277 CAP 505

43

 
Protocol Mapping Tool
Operation Manual

Fig. 4.2.2.-2 shows the components of the pop-up menu shown for the DNP 3.0 
mapping tree in the main window:

menu_popup_dnp

Fig. 4.2.2.-2 Pop-up menu for DNP 3.0 mapping

Fig. 4.2.2.-3 shows the components of the pop-up menu shown for the 
IEC 60870-5-101 mapping tree in the main window:

menu_popup_IEC101

Fig. 4.2.2.-3 Pop-up menu for IEC 60870-5-101 mapping

All pop-up menu items make sense only for certain types of tree nodes, and each 
pop-up menu item is enabled only when the user selects the appropriate type of tree 
node within the mapping tree.

4.2.2.1. Menu items shared by Modbus, DNP 3.0 and IEC 60870-5-101
Change base address

This pop-up menu item allows the user to change the base address of the selected 
data category. This menu item is described in detail in Section 5.4. Complex 
structures under �Base address editing.�

Change conversion factor

This pop-up menu option is used to edit conversion factors of selected analog 
registers. See Section 4.2.3.5. Conversion factor editing for more details.
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Hex points/decimal points

This pop-up menu item allows the user to toggle between hexadecimal and decimal 
values of addresses presented in the mapping tree. See Section 4.2.2.5. Selecting 
address format (Hex/Decimal Points) for more information.

Cut points and Paste points

These pop-up menu options allow the user to cut and paste selected registers within 
the same data category. These operations are thoroughly described in Section 
4.2.3.3. Mapping editing under �Cut and paste operations.�

4.2.2.2. Modbus specific menu items
Change User Register

This pop-up menu item enables the editing of the selected user register. See Section 
5.4. Complex structures under �User registers editing� for more details.

Insert Constant 0

This pop-up menu item inserts a single Constant 0 point just behind the point being 
currently selected within the mapping tree. See Section 4.2.3.3. Mapping editing 
under �Constant 0 points� for more information.

4.2.2.3. DNP 3.0 specific menu items
Disable UR flag

This menu option disables the unsolicited reporting flags of all the currently selected 
points. Section 6.5. Mapping editing features under �Unsolicited reporting 
management� describes this option in detail.

Enable UR flag

This menu option enables the unsolicited reporting flags of all the currently selected 
points. Section 6.5. Mapping editing features under �Unsolicited reporting 
management� describes this option in detail.

Remove Events

This menu item deletes the event definitions from all the currently selected points. 
See Section 6.5. Mapping editing features under �Removing events� for additional 
information.

Assign Class

Assign Class menu option is used to set the appropriate class to events produced by 
the currently selected points. See Section 6.5. Mapping editing features under �Class 
assignment� for additional information.

Insert Constant 0

This pop-up menu item inserts a single Constant 0 point just behind the point being 
currently selected within the mapping tree. See Section 4.2.3.3. Mapping editing 
under �Constant 0 points� for more information.
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4.2.2.4. IEC 60870-5-101 specific menu items
Set Continuous Address Space

This menu option is used to switch to continuous addressing convention. More 
information is provided in Section 7.5.1. Edit menu under �Set continuous address 
space".

Assign General Interrogation Group

This menu item allows to change the GI assignment flag value for the selected data 
points. More information is provided in Section 7.4. Mapping editing features under 
�General interrogation assignment".

Change Measurement Value Format

This menu item allows to change the measurement format for the selected data 
points. More information is provided in Section 7.4. Mapping editing features under 
"Measurement value format change�.

Change Data Class

This menu item allows to change the data class (priority) for the selected data points. 
More information is provided in Section 7.4. Mapping editing features under "Data 
class (priority) assignment�.

4.2.2.5. Selecting address format (Hex/Decimal Points)
This operation concerns all the points defined within the edited mapping. Therefore, 
no tree node must be selected to execute the feature.

4.2.3. Mapping editing features
This section describes the general mapping editing features of the Protocol Mapping 
Tool. These functions are common for Modbus, DNP 3.0 and IEC 60870-5-101.

4.2.3.1. Mapping management
The section describes which mapping management features are available during the 
mapping editing.

Creating a new mapping
To start the creation of a new mapping during the editing of another one, the user 
needs to:

� Select Create New Mapping in the File menu or
� Select the following toolbar button:

rod

� or use the <Ctrl>+<N> keyboard shortcut

By selecting this feature, the user can abandon the editing of a current mapping and 
create a new one. 
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The creation of a new mapping is always supervised by the Protocol Mapping Tool 
Wizard dialog. If a currently edited mapping is changed but not saved, the Protocol 
Mapping Tool will show a message box which induces the user to save a modified 
mapping. 

For more information on the mapping creation process for Modbus, refer to Section 
5.1.1. Creating a new mapping; for DNP 3.0, refer to Section 6.1.1. Creating a new 
mapping and for IEC 60870-5-101, refer to Section 7.1.1. Creating a new mapping.

Opening of an existing mapping
This option allows the user to open an existing mapping stored within a project 
directory. The user can start the feature:

� By selecting Open Mapping File� in the File menu or
� By selecting the following toolbar button:

cap_open

During this operation the mapping browser window will be shown to enable the 
selection of an existing mapping. 

In the browser each stored mapping is marked with the following icon in the file tree 
(see Fig. 4.2.3.1.-1 below):

fpp
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prj_browser

Fig. 4.2.3.1.-1 The mapping file browser

A binary file is created when an edited mapping is saved with the �Save binary file�-
option. In this case, the association between mapping and binary files is established. 
Mapping with an associated binary mapping file is marked with the following icon: 

fppjbin

It is possible that in the beginning only a binary mapping file will be available for a 
certain object. In this case, it will be marked with the following icon:

fbin

If a mapping, with an associated binary mapping file is changed, but the associated 
binary mapping file is not updated, it will also appear in the tree as a separate node 
(because the association no longer exists).

The Delete mapping file button allows the user to remove any mapping file, which 
exists in the browsed location. Neither a binary file nor a mapping file related to the 
binary file can be deleted.

Although multiple mappings can be created for a single relay object, 
only one binary mapping file will be available in the CAP 505 
directory.
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Saving an edited mapping
The mapping and the binary mapping file can be stored in the appropriate CAP 505 
project directory by using either:

� The Save Mapping File� available in the File menu or 
� The following toolbar button:

cap_save

save

Fig. 4.2.3.1.-2 Mapping save dialog 

The Save Binary File check box allows the user to create a binary file associated 
with the saved mapping (used later by the Relay Download Tool in device 
configuration process).

The name of the binary mapping file is automatically set.
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4.2.3.2. Mapping export
This section presents the export features provided by the Protocol Mapping Tool.

Exporting of mapping information
Mapping information can be exported by selecting Export Document File... in the 
File menu. This option is used for documentation purposes and it allows the user to 
export complete information concerning the currently edited mapping. 

Export information is composed of:

� A general description
� A list of function blocks
� A list of signals covered by the mapping + their addresses

Export information can be saved as a HTML or text file. If it is saved as a text file 
after exporting a table, the user can open the text file with an external tool. The 
columns within a text file are separated by tabulator signs.The formats of export files 
generated for different protocols are also different.

 Exporting of point information
Mapping information can be exported by selecting Export Conversion File� in the 
File menu. This feature allows the user to export complete information concerning 
the points defined in the edited mapping.

Export information is composed of rows. Each row contains information concerning 
a single point:

� Address
� Signal description
� Scaling factor
� Value range
� Unit of measure, etc.

Address format can be changed by selecting the appropriate toggle in Conversion 
File Address Format option in the Settings menu (see Section 4.2.1.3. Settings menu, 
Conversion File Address Format submenu for more details).

Export information can be saved as a text file and the user can open it with an 
external tool. The columns within a text file are separated by tabulator signs. 

The formats of export files generated for different protocols are very similar. 
Exported files cannot be imported back into the Protocol Mapping Tool.

For more information on the Export file format, see the Appendix at the end of this 
manual.

Exported files cannot be imported back into the Protocol Mapping 
Tool.
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4.2.3.3. Mapping editing 
This section describes all the editing features available within the Protocol Mapping 
Tool.

Adding new points

To add new points to the mapping, the user has to:

� Select Add points in the Edit menu or
� Select the following toolbar button or 

plus

� Use the <Ins> keyboard shortcut

This feature allows the user to add new points into the mapping. Selecting Add 
Points in the Edit menu shows the Add Points dialog as presented in Fig. 4.2.3.3.-1.

add_rem

Fig. 4.2.3.3.-1 Add Points dialog

The left tree of the Add Points dialog shows all the points available to be added for 
the selected pattern. The right tree contains all the points selected by the user.

The user may select required points in the left tree and press the >> button to copy 
them into the right tree. A particular point can be added more than once.

This option is available in the advanced mode.
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The user may also select a point and click the << button to remove that point from 
the right tree. More than one point can be selected.

When the user presses the OK button, all the points stored in the right tree are added 
to a current mapping at the end of the current point list. 

To see the points available for another pattern, the user has to select an appropriate 
pattern in the top-most combo box called �Points of function block� (see 
Fig. 4.2.3.3.-1).

Removing existing points

If required, unnecessary points can be removed from the mapping. The Protocol 
Mapping Tool removes the currently selected points.

To start this operation the user should:

� Select Delete Points from the Edit menu or
� Select the following toolbar button: 
 

minus

� Use <Del> keyboard shortcut

By default, an additional warning is shown when the user tries to remove any point 
from the current mapping. The warning is skipped when the Warn Before Item 
Deleted option in the Settings menu is unchecked. The user can also quickly 
uncheck this option when the warning is shown (see Fig. 4.2.3.3.-2).

delete_confirm

Fig. 4.2.3.3.-2 Confirmation dialog during point deletion

Cut and paste operations.

Cut and paste operations are used to move selected points.

Cut operation is available by:

This option is available in the advanced mode.

These options are available in the advanced mode.
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� Selecting Cut points in the Edit menu or
� Selecting Cut points in the pop-up menu or
� Clicking the following toolbar button

sciz

� Using keyboard shortcut: <Ctrl>+<X>

Protocol Mapping Tool cuts the currently selected points. Cut points stay in the same 
position and wait for the Paste Points operation to be executed.

cut_points

Fig. 4.2.3.3.-3 Cut points

Paste operation is executed when the user:

� Selects paste points in the Edit menu or
� Selects paste points in the pop-up menu or
� Clicks the following toolbar button or
 

paste

� Uses keyboard shortcut: <Ctrl>+<V>

Cut points are always pasted just behind points being currently selected as a 
destination location. If the user wants to paste cut points at the beginning of the data 
category, a data category branch must be selected as a destination location. 

The Protocol Mapping Tool does not allow moving points between different data 
categories.

It is also possible to use drag&drop in order to move selected points within the 
mapping tree.

Point dragging is started when the user clicks and holds the left mouse button over 
the area occupied by selected points. During dragging all the dragged points are 
marked as cut (their background color is red) and the cursor is changed (see 
Fig. 4.2.3.3.-4): 
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drag_cursor

Fig. 4.2.3.3.-4 A drag&drop cursor

To finish the drag&drop operation, the user has to release the left mouse button. In 
this case, dragged points are dropped into the location pointed by the cursor (just 
behind points being currently selected as a destination location). 

drag_operation

Fig. 4.2.3.3.-5 A drag&drop operation

Constant 0 points
A Constant 0 point is a special point that has a conversion factor equal to 
DUMMY_0. All Constant 0 points always return 0 and have no special meaning. 
Therefore, they can be used to fill gaps between two separated sub-ranges of points 
within the same data category (see Fig. 4.2.3.3.-6).

constant_0_reg

Fig. 4.2.3.3.-6 Constant 0 register

4.2.3.4. Verification against patterns

Verification against patterns compares existing points in the mapping with the points 
defined in the current patterns. If differences are found, the user is notified and given 
a chance to change such points within the mapping. 

This option is available in the advanced mode.



54

1MRS755277 
Protocol Mapping Tool
Operation Manual

CAP 505

Mapping verification shows differences in the mapping, if any pattern is updated. It 
is a convenient solution for maintaining mappings, when patterns are revised.

The mapping verification is started by:

� Selecting Verify Against Patterns in the Edit menu or
� Using <Ctrl>+<A> keyboard shortcut

The result of the mapping verification is shown in a separate window as a set of 
message lines describing individual verification differences (see Fig. 4.2.3.4.-1).

mapp_ver_window

Fig. 4.2.3.4.-1 Results of the mapping verification before fixing

All the messages are shown in three categories distinguished by appropriate icons:

1. Errors 

msg_error

2. Warnings

msg_warning

3. Informative

msg_info

To solve the problems shown by the mapping verification, the user has to check the 
appropriate check boxes and press the Fix Selected button. Errors and warnings have 
their check boxes selected by default. 
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The mapping verification is capable of detecting and solving the following 
problems:.

Table 4.2.3.4-1 Mapping verification messages

Message/Problem Message category Fixing

Common messages:

Address space is not continuous Error Points readdressed

Point already existing in the mapping Informative Point removed

Missing point found in pattern Warning Point added to the mapping

Point added from not default pattern Warning Point removed

Point not existing in pattern Error Point removed

Unknown point found in pattern Error Point removed

Unknown error detected (Invalid flag 
active)

Warning Flag cleared

Incorrect block detected (No block flag 
active)

Warning Flag cleared

Incorrect point definition detected (No 
object flag active)

Warning Flag cleared

Point updated (Corrected flag active) Warning Flag cleared

Incorrect number of events Error Events restored

(row #) Incorrect database name Error Database name restored

(row #) Incorrect datatype Error Datatype restored

(row #) Incorrect IU flags Warning IU flags restored

Editable conversion factor changed by a 
user

Informative Default conversion factor restored

Point having incorrect conversion factor Warning Default conversion factor restored

Modbus specific messages:

Pack registers corrupted Error Pack registers restored

Missing change detect signal Error Change detect signal restored

Orphaned change detect signal Error Change detect signal removed

·User-defined registers

Empty user-defined register Error User-defined register removed

User register maps an already mapped 
analog registers

Warning User-defined register removed

User register in slot # maps an already 
mapped binary register

Warning Slot # cleaned up

·Control structures

Control structure corrupted Error Control structure removed

Missing control point found in pattern Warning Control point added to the mapping (but not 
added to a control structure)

Control point added from not default 
mapping

Warning Control point removed

Control point not existing in pattern Error Control point removed



56

1MRS755277 
Protocol Mapping Tool
Operation Manual

CAP 505

When the Fix Selected button is clicked, all the verification differences having their 
check boxes checked are fixed. However, they are not all removed from the list but 
are distinguished by changing their background color into light green (see 
Fig. 4.2.3.4.-2).

Unknown control point found in the 
mapping

Error Control point removed

DNP specific messages:

Events removed Informative Events restored

(row #) Incorrect default variation mask Warning Default variation mask restored

(row #) Incorrect default function mask Warning Default function mask restored

Incorrect static point's class Error Class 0 restored

Event's class changed by a user Informative Default class restored

Incorrect event class Error Default class restored

Unsolicited reporting flag deactivated by a 
user

Informative Default unsolicited reporting flag restored

Incorrect unsolicited reporting flag Error Default unsolicited reporting flag restored

IEC 60870-5-101 specific messages:

Assignment to general interrogation 
group changed by the user

Informative Default interrogation group restored

Incorrect assignment to general 
interrogation group

Error Default interrogation group restored

Measurement value format changed by 
the user

Informative Default measurement value format restored

Incorrect measurement value format Error Default measurement value format restored

Data class changed by the user Warning Default data class restored

Incorrect data class Error Default data class restored

Table 4.2.3.4-1 Mapping verification messages

Message/Problem Message category Fixing
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mapp_ver_wind_fixed

Fig. 4.2.3.4.-2 Fixed and remaining verification differences available in the 
mapping verification window.

Any point defined in the verified mapping may have more than one verification 
difference at the same time. If the fixing of a problem consists of removing the whole 
point from the mapping (e.g. see Fig. 4.2.3.4.-3 and �Point already existing in the 
mapping�), a description "(NODE REMOVED)" is added to all the other differences 
related to the removed point.

mapp_ver_wind_removed

Fig. 4.2.3.4.-3 Maintaining verification differences for removed points

4.2.3.5. Conversion factor editing
A Change Conversion Factor menu option is used to edit conversion factors of 
selected analog registers.

Fig. 4.2.3.5.-1 depicts the conversion factor editor.

conv_factor_editor

Fig. 4.2.3.5.-1 The conversion factor editor
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The conversion factor editing is possible only for analog points of data type 
EV_REAL and one of the conversion factors listed above set. Other analog points 
have the operation disabled. 

If the operation is executed for more than one register and the 
selected registers have no common conversion factor, the conversion 
factor editor will present the "Multiply by 1" value by default 
(regardless of conversion factors being set within all edited 
registers). 
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5. Modbus

This chapter provides detailed description of all the Protocol Mapping Tool features 
supporting the Modbus protocol.

5.1. Protocol Mapping Tool Wizard
The user can decide whether to create a new mapping, open an existing one or import 
a mapping from a different relay object. It is also possible to delete mappings no 
longer needed.

wizard_new

Fig. 5.1.-1 The Protocol Mapping Tool Wizard

5.1.1. Creating a new mapping
Supported categories and their default addresses differ from various terminals. They 
are presented in Fig. 5.1.1.-1 (REM 54_) and in Fig. 5.1.1.-2 (REF 54_ and 
RET 54_).

Choosing the point base addresses of data categories
Selected addresses can be changed later during the editing. This is described later in 
this chapter under Base address editing. An Overlapping-check is performed for the 
Modbus protocol, which is described under Overlapping check.
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REM 54_terminal

wizard_iec

Fig. 5.1.1.-1 Choosing the point base addresses of data categories (for the REM 
54_ terminal).

Supported data types:

� Coils
� Digital Inputs
� Input Registers
� Holding Registers

Category of data points:

� Process Data (basic): state values mapped to Digital Inputs (basic address range 
of Digital Inputs)

� Process Data (extended): two Digital Inputs points per signal - state value 
followed by momentary Change detect bit in the consecutive address (extended 
address range of Digital Inputs)

� Slowly Changing: Slowly changing binary data (without change events)
� Control: Control parameters
� Diagnostics: Diagnostic parameters
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REF 54_ and RET 54_ terminals

wizard_ref

Fig. 5.1.1.-2 Choosing the point base addresses of data categories (for REF 54_ 
and RET 54_ terminals).

After performing this step, the Protocol Mapping Tool will open with a new 
mapping.

5.2. Mapping tree
All the points maintained by a mapping are put into several different categories and 
subcategories. Such categories and subcategories create branches of a mapping tree 
(see Fig. 5.2.-1): 

mapping_tree

Fig. 5.2.-1 A piece of mapping tree showing its branches and leaves

The number of categories/subcategories and the way points are mapped into those 
categories depend on the selected application.

Table 5.2.-1 Elements visible in Fig. 5.2.-1:
Data category: Coils/Digital inputs 
Data subcategory: Process data basic range
Point: 00003 PS1_14-C Output 3 state
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If a mapping is read from a device, some points may have warning flags set. There 
are four warning flags:

1. Invalid (entry for a given point contains invalid information - point removed 
from the data map)

2. Corrected (the entry for a given point contained incorrect information and was 
corrected by the device during mapping parsing)

3. No block (the device application does not have a function that contains this data 
- point removed from the data map)

4. No object (the device application does have a function, but there is no such data 
item - point removed from the data map)

Tree nodes, which represent registers with warning flags set, have different 
background colors (see Fig. 5.2.-2):

� Purple background color indicates object flag set
� Light green background color indicates no block flag set
� Yellow background color indicates corrected flag set
� Red background color indicates incorrect flag set

warning_flags_modbus

Fig. 5.2.-2 The example of tree nodes indicating active warning flags

When the user leaves the cursor over a tree node for a while, a tooltip window will 
be shown (see Fig. 5.2.-3).

tooltip_modbus

Fig. 5.2.-3 Tooltips for a Modbus register 

The following tooltip is shown if the user leaves the cursor over an addressed data 
category or data object, i.e. "Coils\Process data extended range" within the Modbus 
mapping tree (see Fig. 5.2.-4):

Table 5.2.-2 Mapping tree register elements:
Address 00003 (or 0003H hexadecimal address format is selected)
Function PS1_14 
Function revision C
Description Output state 3
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tooltip_datac

Fig. 5.2.-4 Tooltip window for an addressed data category

The structure of the mapping tree during the editing of Modbus mapping depends on 
the selected device.

Each Modbus mapping tree is composed of three kinds of data objects: 

1. Data types
2. Data (sub)categories
3. Data points

The former two data objects are tree branches, whereas the latter one is always a leaf.

A Modbus-dependent mapping tree is composed of up to four Modbus data types 
(main categories) and each Modbus data type is composed of up to five data 
categories. All Modbus points are mapped into one of the available Modbus data 
categories.

5.3. Mapping conventions

5.3.1. Mapping convention of REM 54_
� Simple (1 to 1) mapping of application data into Modbus types
� All read-only binary data (function block inputs and outputs) are mapped into 

digital inputs
� Switching device position (2-bit) is mapped into three digital inputs (open/close 

state on two digital inputs and faulty state indication on the third digital input) 
and additionally to an input register, containing a switch state encoded on 2 bits 
(0 - middle, 1 - close, 2 - open, 3 - faulty)

� Control operations are made via coils
� All measurements are mapped into input registers
� Parameters and settings are mapped into holding registers
� Change detect flags are associated with binary inputs and outputs 
� User-defined holding registers are used for grouping selected data mapped into 

digital inputs and coils or input registers

Fig. 5.3.1.-1 shows data categories for REM 54_.
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mt_modbus_rem

Fig. 5.3.1.-1 Data categories within a mapping tree for REM 54_

5.3.2. Mapping convention of REF 54_and RET 54_
� Digital data points are readable Coils or Digital Inputs
� Analog data points are readable Holding Registers or Input Registers
� Points defined as basic range process data Coils/Digital Inputs are created 

optionally
� Switching device position (2-bit) is mapped into three digital inputs (open/close 

state on two digital inputs and faulty state indication on the third digital input) 
and additionally to an input register, containing a switch state encoded on 2 bits 
(0 - middle, 1 - close, 2 - open, 3 - faulty)

� Pack Registers is a data category composed of automatically created 16-bit read-
only registers containing basic range and extended range process data Coils

� Device Data is a data category
� Basic range process data category in Holding Registers/Input Registers is used to 

store user-defined registers, which are provided for grouping selected data 
mapped into digital inputs and coils or holding registers

� Measurement data points are placed in Extended range Holding Registers/Input 
Registers 

� Diagnostic data category is not supported (Diagnostic points are converted into 
Slowly Changing signals)

� Control structures and user-defined registers are not supported (these points are 
dropped)

Fig. 5.3.2.-1 shows data categories for REF 54_ and RET 54_.
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mt_modbus_ref

Fig. 5.3.2.-1 Data categories within a mapping tree for the REF 54_ and 
RET 54_

5.4. Complex structures
Modbus mappings support complex structures. In some cases such structures are 
composed of many registers presented as a compact undividable set of nodes within 
a mapping tree.

Low Word/High Word Analog Registers
Low Word Analog Register and High Word Analog Register forms a structure of 
two compact registers and are used to map 32-bit values (2 x 16-bit registers).

Fig. 5.4.-1 presents an example of a Low/High Word structure:

lowhigh_word_reg

Fig. 5.4.-1 Low and High Word Analog Registers

Appropriate Low and High Word Analog Registers cannot be split. These are always 
next to each other and is treated as a single structure.

Analog points having an editable conversion factor
Some analog points have a conversion factor, which can be changed by using the 
appropriate menu option. The editable conversion factors are:

� Multiply by 1 (no operation)
� Multiply by 10 unsigned
� Multiply by 100 unsigned
� Multiply by 1000 unsigned
� Divide by 10 unsigned
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� Divide by 100 unsigned
� Divide by 1000 unsigned
� Multiply by 10 signed
� Multiply by 100 signed
� Multiply by 1000 signed
� Divide by 10 signed
� Divide by 100 signed
� Divide by 1000 signed

Analog registers having editable conversion factors are presented as single registers 
with an additional description of the current conversion factor inside square brackets 
(see Fig. 5.4.-2).

analog_reg_conv_factor

Fig. 5.4.-2 Example of an analog register having an editable conversion factor

User Registers (User-Defined Registers)
User-defined registers are used to map the different already existing data points into 
a shared data category (user registers are mapped as Holding Registers within 
Process data basic range/User-Defined data category).

A single user-defined register is able to load:

� One analog register (Holding Register or Input Register)
� Up to 16 binary points (Coils or/and Digital Inputs)

A User Register containing an analog register is called a user analog register, 
whereas a user register containing up to 16 binary points is called a user bit-field 
register.

Fig. 5.4.-3 below depicts the user registers within a mapping tree:

user_registers

Fig. 5.4.-3 Analog user register and bit-field user register

User registers are created as Holding Registers within the Process Data Basic Range 
(alias User Defined Registers) data category. The user register's identification 
number and its address are assigned automatically.

The user register's identification number is seen as a part of the name in the mapping 
tree, i.e. the following description 'User defined register 3 [Bit field: 10 bits 
assigned]' refers to the user register no. 3.

The description of a user register presented in the mapping tree contains an 
additional section (bounded by square brackets), which describes the type and 
content of the user register.
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The information presented in a tooltip window contains an even more detailed 
description of the user register: an identification number (i.e. User register 2), 
register's type (i.e. Register type: bitfield) and a list of mapped registers (see 
Fig. 5.4.-4 and Fig. 5.4.-5): 

tooltip_modbus_ura

Fig. 5.4.-4 Tooltips for an analog user register

tooltip_modbus_urb

Fig. 5.4.-5 Tooltips for a bit-field user register

The Protocol Mapping Tool is able to manage up to 256 user defined registers in a 
single mapping.

Pack Registers

Pack registers are provided for packing a sequence of digital signals in the order 
determined by the order of coils on the Modbus map. Each pack register contains up 
to 16 binary points mapped from basic and extended process data ranges of coils.

Pack registers are read-only registers, which are created automatically when a 
mapping is created and updated any time a mapping is changed. 

Pack registers are stored as holding registers in a separate data category (see 
Fig. 5.4.-6).

Pack registers are supported only in Modbus-dependent mappings 
created for REF 54_ and RET 54_devices.
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pack_registers

Fig. 5.4.-6 Pack registers

Tooltip information presented for pack registers allows the user to check which coils 
are mapped.

Tooltip information is composed of a source data category and a list of mapped 
binary registers.

tooltip_modbus_pr

Fig. 5.4.-7 A tooltip for a certain pack register
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Creation of Constant 0 points

The user can insert a Constant 0 point by selecting the "Insert Constant 0" option:

� In the Edit menu or
� From the Edit window's pop-up menu

A Constant 0 point is always put just behind points selected as a destination location. 
If the user wants to put a Constant 0 point at the beginning of the data category, the 
data category branch must be selected as a destination location.

Constant 0 points are also used to replace not supported points during the mapping 
file import.

Base address editing

The "Change base address" pop-up menu item allows the user to change the base 
address of the selected data category.

As a result, all the registers within such a data category are readdressed.

A dialog box is used to enter a new base address (see Fig. 5.4.-8). 

base_address_edition

Fig. 5.4.-8 Base address editor

The format of an edited address (either decimal or hexadecimal value) presented in 
the base address editor depends on the format of the addresses presented in the 
mapping tree. 

This option is available in the advanced mode.

Add 15 constant 0 points to the end of the data category. That makes 
it possible to define the polling topic easier. The topic needs to be a 
number of full 16 bits words. If the topic contains more bits than 
exists in the relay�s data category, the relay answers nothing to the 
poll.

This option is available in the advanced mode.
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The order of data categories within Modbus mapping

modbus_addr_ed1

Fig. 5.4.-9 The order of Modbus data categories before the base address change

Changing the base address of the "Pack registers" data category (from address 1024 
to address 510) will change the sequence of data categories as well - "Pack registers" 
category is ahead of "Process data extended range" category (see Fig. 5.4.-10).

modbus_addr_ed2

Fig. 5.4.-10 The order of Modbus data categories after the base address of "Pack 
registers" category was changed to address 510.

Apart from that, the overlapping check operation proceeded (it is active by default) 
and moved the overtaken category (from address 512 to address 524) to avoid the 
address conflicts. 

Overlapping check

The Overlapping check can be started by selecting Check Overlapping in the 
Overlapping submenu within the Edit menu.

This menu feature starts the procedure of the data category address range checking 
within Modbus data types to determine whether any data category begins at a 
memory address, which is reserved by registers belonging to other data category. 
When that kind of memory arrangement occurs the overlapping check procedure 
will change the base address of the latter data category (and move its registers into 
a new location).

For Modbus mappings, readdressing is often connected with the 
changing of the location of Modbus data categories to preserve their 
correct order in the mapping tree, i.e. the given five data categories 
within the "Holding registers/Input registers" data type (see 
Fig. 5.4.-9).

This option is available in the advanced mode.
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The Auto Check menu toggle in the Overlapping submenu within the Edit menu is 
also available. It is used to enable/disable the automatic start of the Overlapping 
check procedure each time the mapping has been changed during the editing.

By default, auto check is enabled.

User registers editing

The creation of a new user-defined register is started by:

� Selecting the User Register menu item in the Create submenu in the Edit menu or
� Selecting the following toolbar button or
 

create_ur

� Using <Ctrl>+<U> keyboard shortcut

Since the Protocol Mapping Tool supports two kinds of user registers, the user has 
to select the type for a new user register (see Fig. 5.4.-11).

ur_create

Fig. 5.4.-11 User register type selection

Analog User Register
Selected analog data and data with integer values (measurements, counters, 
diagnostic data, settings) mapped to holding registers can be replicated to the user-
defined holding registers by using the User Analog Register Editor (see Fig. 5.4.-
12).

This option is available in the advanced mode.
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an_ur

Fig. 5.4.-12 User Analog Register Editor

When the user selects the OK button, the Protocol Mapping Tool checks other 
analog user defined registers to ensure that the selected register is not mapped yet. 
If a duplicate is found, Fig. 5.4.-13 will be shown:

duplicates_analog

Fig. 5.4.-13 Warning message seen, when a duplicate of an analog register is 
found.

The warning is skipped when the Check Duplicates Before User Register Added 
option in the Settings menu is unchecked. The user can also quickly uncheck this 
option when the warning is shown (see Fig. 5.4.-13 above).
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Bit Field User Register
Selected binary signals, with or without their momentary change detect flags 
represented by coils or digital inputs, can be mapped to bit positions in user-defined 
holding registers. In this way holding registers can contain groups of binary signal 
data. This grouping of binary signals enables more efficient data scanning in the 
Modbus protocol.

Bit field user registers are created by using the User Bit Field Editor (see Fig. 5.4.-
14).

bf_ur

Fig. 5.4.-14 User Bit Field Editor

To add a new binary register to the edited bit field, select the required register in the 
left tree and press the >> button. The added binary register is put into the first empty 
slot presented in the right tree.

When the >> button is selected, the Protocol Mapping Tool checks the already 
existing bit-field user defined registers to ensure that the selected binary registers are 
not yet mapped. If a duplicate is found, a warning message as in Fig. 5.4.-15 will be 
shown:

duplicates_binary

Fig. 5.4.-15 Warning message seen, when a duplicate of a binary register is found
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If the Check duplicates before user register added option in the Settings menu is 
unchecked, the PMT does not show any warning. The user can also quickly uncheck 
this option when the warning is shown (see Fig. 5.4.-15 above). 

To remove already added binary register, the user has to select such an item in the 
right tree and press the << button.

The order of added binary registers can always be changed by using the drag&drop 
operation.

The user is able to change any of the existing user registers:

� By selecting User Register in the Change submenu in the Edit menu or
� By selecting the following toolbar button:

change_ur

� y selecting Change User Register in the Protocol Mapping Tool window's pop-up 
menu

First of all, the user has to select which user register must be edited. Fig. 5.4.-16 
allows the user to set the identification number of the required user register:

ur_edit

Fig. 5.4.-16 Selection of a user register's identification number

There is no need to select a user register's identification number, if user the editing 
of the register is started by using the Protocol Mapping Tool window's pop-up menu.

In the second step, the appropriate editor is presented depending on the type of 
selected user register (see Fig. 5.4.-17 and Fig. 5.4.-18 below).
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an_ur_edit

Fig. 5.4.-17 The user analog register editor

bf_ur_edit

Fig. 5.4.-18 The user bit field register editor
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The editing of user register proceeds in the same manner as if the user register has 
only just been created.

Fore details on user registers see Section 5.4. Complex structures under User 
Registers (User-Defined Registers).

5.5. Modbus specific menu items and submenus

5.5.1. Edit menu
Fig. 5.5.1.-1 shows the components of the Edit menu of the Protocol Mapping Tool.

menu_edit_rem

Fig. 5.5.1.-1 The Edit menu for Modbus mapping

5.5.1.1. Create submenu
Fig. 5.5.1.1.-1 shows the components of the Create submenu of the Protocol 
Mapping Tool. 

menu_edit_create_ref

Fig. 5.5.1.1.-1 Create submenu

(Create) User Register

By selecting the User Register menu item in the Create submenu of the Edit menu, 
the creation of a new user register is started. This feature is described in Section 5.4. 
Complex structures under User registers editing.

More information can be found in Section 5.4. Complex structures under User 
Registers (User-Defined Registers).

This option is available in the advanced mode.
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Toolbar button:
 

create_ur

Keyboard shortcut: <Ctrl>+<U>

5.5.1.2. Change submenu
Fig. 5.5.1.2.-1 shows the components of the Change submenu of the Protocol 
Mapping Tool.

menu_edit_change_ref

Fig. 5.5.1.2.-1 Change submenu

(Change) User Register

By selecting this feature, the user is able to change any of already existing user 
registers within the mapping. The description of the feature is available in Section 
5.4. Complex structures under User registers editing.

Toolbar button: 

change_ur

5.5.1.3. Overlapping submenu
This section covers menu items within the Overlapping submenu placed in the Edit 
menu. The Overlapping submenu is shown in Fig. 5.5.1.3.-1:

menu_edit_overlapping

Fig. 5.5.1.3.-1 Overlapping submenu

Check overlapping

This menu option starts the procedure of the data category address range checking 
within Modbus data types to determine whether any data category begins at a 
memory address, which is reserved by registers belonging to another data category. 
The Overlapping check is described in detail in Section 5.4. Complex structures 
under Overlapping check.

This option is available in the advanced mode.

This option is available in the advanced mode.
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Auto check
Auto check is a menu toggle used to enable/disable the automatic start of the 
overlapping check procedure each time the mapping has been changed during the 
editing. The "Overlapping check" is described in detail in Section 5.4. Complex 
structures under Overlapping check.

5.5.2. Settings menu
The Settings menu of the Protocol Mapping Tool is presented in Fig. 5.5.2.-1:

menu_settings_rem

Fig. 5.5.2.-1 The Settings menu

Check Duplicates Before User Register Added
This menu toggle enables/disables the looking for duplicated entries within user 
defined registers. Section 5.4. Complex structures under Analog User Register and 
Bit Field User Register describes how this setting is used.

Warn Before Item Deleted
This menu toggle enables/disables the warning shown each time the user tries to 
remove any register from a mapping tree. See Section 4.2.3.3. Mapping editing 
under Removing existing points for more details on the using of the setting.

5.6. Modbus specific pop-up menu
The section describes the Modbus specific pop-up menu available for the mapping 
tree in the Protocol Mapping Tool.

Fig. 5.6.-1 shows the components of the pop-up menu shown for the mapping tree 
in the main window:

menu_popup_ref

Fig. 5.6.-1 Pop-up menu for Modbus mapping editing
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All pop-up menu items make sense only for certain types of tree nodes and each pop-
up menu item is enabled only when the user selects the appropriate type of tree node 
within the mapping tree.

Change User Register
This pop-up menu item enables the editing of the selected user register. See Section 
5.4. Complex structures under User registers editing for more details.
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6. DNP 3.0

This chapter provides a detailed description of all the Protocol Mapping Tool 
features supporting the DNP 3.0 protocol.

6.1. Protocol Mapping Tool Wizard
Fig. 6.1.-1 shows the Protocol Mapping Tool Wizard. First the user decides whether 
to create a new mapping, open an existing one or import a mapping from a different 
CAP project. It is also possible to delete mappings no longer needed.

wizard2_new

Fig. 6.1.-1 The Protocol Mapping Tool Wizard

6.1.1. Creating a new mapping
The user needs to choose the way of processing events and the point base addresses 
of data categories.

Choosing the way of processing events
Some protocol points contain events and the user can decide how to process these 
points (see Fig. 6.1.1.-1). Events can be removed later during editing, which is 
described in Section 6.5. Mapping editing features.
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wizard4_dnp

Fig. 6.1.1.-1 Choosing the way of processing events

Add all available events
Unsolicited reporting flag is set the same way as in patterns (by default, set to 
enabled = 1)

Add all available events but reset UR flags
Unsolicited reporting flag is reset for every event. Selecting this option causes the 
device NOT to send any events spontaneously. This option should be used in 
installation where communication is half duplex and there is no common system-
wide collision avoidance/detection procedure.

Create only static points without events
Events will be removed totally from the mapping. Instead, all the points will be 
updated via background scan. This option should be used ONLY if the master 
station does not understand events and does not perform class 1,2,3 scans at all. 
Using this option will prevent event buffer overflows.

Choosing the point base addresses of data categories
Supported categories and their default addresses are presented in Fig. 6.1.1.-2 
below. Selected addresses can be changed later during the editing, which is 
described in Section 6.5. Mapping editing features
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wizard5_dnp

Fig. 6.1.1.-2 Choosing the point base addresses of data categories (for DNP 3.0 
protocol).

After performing this step, the Protocol Mapping Tool will open with a new 
mapping.

6.2. Mapping tree
The structure of a mapping tree is fixed during the editing of the DNP 3.0 mapping 
(see Fig. 6.2.-1).

mapping_tree_dnp

Fig. 6.2.-1 Data objects within the DNP 3.0 mapping tree

Data objects are represented by branches with the following icon:
 

gategory

DNP 3.0 points can produce both static and dynamic (event) information. It can be 
determined by a tree node icon set for a tree node representing a single register:
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1. Node containing only static points

points3

2. Node containing only events (static information is also available, but is based on 
the value of the last triggered event)

events3

3. Node containing both static points and events

points_events3

If a mapping is read from a device with the Relay Download Tool, some points may 
have warning flags set. There are four warning flags:

� Invalid (the entry for a given point contains invalid information - point removed 
from data map)

� Corrected (the entry for a given point contained incorrect information and was 
corrected by the device during mapping parsing)

� No block (the device application does not have a function that contains this data - 
point removed from the data map)

� No object (the device application does have a function, but there is no such data 
item - point removed from the data map)

Tree nodes representing registers with warning flags set have different background 
colors (see Fig. 6.2.-2):

� Purple background color indicates object flag set
� Light green background color indicates no block flag set
� Yellow background color indicates corrected flag set
� Red background color indicates incorrect flag set

warning_flags

Fig. 6.2.-2 Example of tree nodes indicating the active warning flags

Table 6.2.-1 Mapping tree register elements
Address 00005 (or 0005H hexadecimal address format is selected)
Function AR5Func
Function revision D
Description Breaker position
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When the user leaves the cursor over a tree node for a while, a tooltip window will 
be shown (see Fig. 6.2.-3).

tooltip_dnp

Fig. 6.2.-3 Tooltips for a DNP 3.0 register

The following tooltip will be shown if the user leaves the cursor over an addressed 
data category or data object, i.e. Binary Inputs/Binary Input Events within the DNP 
3.0 mapping tree (see Fig. 6.2.-4).

tooltip_datac

Fig. 6.2.-4 Tooltip window for an addressed data category

6.3. Mapping conventions
The DNP 3.0 protocol supports the following mapping convention:

� Binary input objects are used to represent the state of the digital input points 
(hardware or software).

� Binary output objects are used to represent the state of controllable binary points 
(hardware or software).

� Control relay output block information objects are used to make control 
commands on binary output points. 

� Binary counters represent accumulated values. They can be accumulated pulses 
or transitions from hardware or software points.

� Analog inputs are information objects used to represent hardware or software 
analog points. Their values can represent digitized signals or calculated values.

� Analog output status information objects represent the actual values of analog 
output points and associated statuses.

� Analog output block information objects are used to set a new value for analog 
output points.

� Time and date objects are the objects that represent the time of day and date used 
to perform time synchronization.

� Internal indications are information elements used to convey internal states and 
diagnostic results of a responding station.

Points from Timers and Internal Indications must always be present in mapping and 
cannot be altered by the user. The user can change the content of Applications 
category, but its base address cannot be changed.

6.4. Complex structures
DNP 3.0 mappings support:
� Analog points having an editable conversion factor
� Internal indications
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Analog points having an editable conversion factor
Some analog points have a conversion factor, which can be changed by using the 
appropriate menu option. The editable conversion factors are:

� Multiply by 1 (no operation)
� Multiply by 10 (signed)
� Multiply by 100 (signed)
� Multiply by 1000 (signed)
� Divide by 10 (signed)
� Divide by 100 (signed)
� Divide by 1000 (signed)

Internal indications
Internal indication are information elements used to convey internal states and 
diagnostic results of a responding station. This information can be used by a 
receiving station to perform error recovery or other functions.

The definitions of internal indications are stored in a separate data category called 
Internal Indications within DNP 3.0 mapping. The Internal Indication data category 
is not editable and is composed of 16 binary points. 

The meaning of 16 internal indications is specified in Table 6.4.-1 below:

Table 6.4.-1 The meaning of 16 internal indications:

Internal indication Meaning
Bit 0 All stations message received
Bit 1 Class 1 data available
Bit 2 Class 2 data available
Bit 3 Class 3 data available
Bit 4 Time-synchronization required from the master
Bit 5 Set when some or all of the Outstation's digital output points are in the 

Local state
Bit 6 Device trouble
Bit 7 Device restart
Bit 8 Function code not implemented
Bit 9 Requested object(s) unknown

Bit 10 Parameters in the qualifier, range or data fields are not valid or out of 
range

Bit 11 Event buffer(s), or other application buffers have overflowed
Bit 12 Request understood but requested operation is already executing
Bit 13 Set to indicate that the current configuration in the Outstation is corrupt
Bit 14 Reserved for use by agreement, currently always returned as zero (0)
Bit 15 Reserved for use by agreement, currently always returned as zero (0)
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6.5. Mapping editing features

Base address editing

The "Change base address" pop-up menu item allows to change the base address of 
the selected data category. As a result, all registers within such a data category will 
be readdressed. A dialog box is used to enter a new base address (see Fig. 6.5.-1 
below).

base_address_dnp

Fig. 6.5.-1 Base address editor

The format of an edited address (either decimal or hexadecimal value) presented in 
the base address editor depends on the format of the addresses presented in mapping 
tree. 

Removing events

This operation removes the event definitions from points defined within the 
mapping.

The Protocol Mapping Tool provides two ways of removing events:

1. Removing all events within all the defined points either by selecting Remove 
All Events in the Edit menu or by selecting the following toolbar button:

 

remove_events

2. Removing events within the currently selected points by selecting Remove 
Events in a pop-up menu.

Such an action must be confirmed (see Fig. 6.5.-2).

This option is available in the advanced mode.

This option is available in the advanced mode.



88

1MRS755277 
Protocol Mapping Tool
Operation Manual

CAP 505

remove_events_confirm

Fig. 6.5.-2 Operation confirmation 

Unsolicited reporting management
All DNP 3.0 events defined within static points have associated unsolicited 
reporting flag (UR flag). The Protocol Mapping Tool allows the editing of this flag.

The user can enable all UR flags within events defined in all static points either by 
using Enable All UR Flags in the Edit menu or by selecting the following toolbar 
button:

urep1

To enable UR flags only for currently selected points, the user has to choose Enable 
UR flags in a pop-up menu.

Similarly, the following ways can be used to disable all unsolicited reporting flags 
for events within all defined static points:

� By selecting Disable All UR Flags in the Edit menu or
� By selecting the following toolbar button: 

urep0

To disable UR flags only for selected points, the user needs to choose Disable UR 
Flags within a pop-up menu.

Class assignment
Class assignment is used to set an appropriate class to events provided by currently 
selected points.

Fig. 6.5.-3 is used to assign class (see below):

The Removing events operation is irreversible.
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class_editor

Fig. 6.5.-3 The class editor

The following values are available during class editing:

� Class 1
� Class 2
� Class 3
� Not assigned

6.6. DNP 3.0 specific menu items

6.6.1. Edit menu
Fig. 6.6.1.-1 shows the components of the Edit menu of the Protocol Mapping Tool.

menu_edit_dnp

Fig. 6.6.1.-1 The Edit menu for DNP 3.0 mapping

If operation is executed for more than one point, the class editor will 
present a "Not assigned" value by default (regardless of class values 
being currently set within all edited points).
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Assign Class
This menu option is used to set the appropriate class to events produced by the 
currently selected points. More information is provided in Section 6.5. Mapping 
editing features under Class assignment. 

Enable All UR Flags
This menu option enables the unsolicited reporting flag for events mapped within all 
registers defined in the mapping. More information is provided in Section 6.5. 
Mapping editing features under Unsolicited reporting management.

Toolbar button: 

urep1

Disable All UR Flags
This menu option disables the unsolicited reporting flag for events mapped within 
all registers defined in the mapping. More information is provided in Section 6.6. 
DNP 3.0 specific menu items under Unsolicited reporting management.

Toolbar button: 

urep0

Remove All Events

This operation removes the event definitions from all registers defined within the 
mapping. More information is provided in Section 6.5. Mapping editing features 
under Removing events. 

Toolbar button: 

remove_events

6.7. DNP 3.0 specific pop-up menu
This section describes the DNP 3.0 specific pop-up menu available for the mapping 
tree in the Protocol Mapping Tool.

Fig. 6.7.-1 shows the components of the pop-up menu shown for the mapping tree 
in the main window:

This option is available in the advanced mode.
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menu_popup_dnp

Fig. 6.7.-1 Pop-up menu for DNP 3.0 mapping editing

Pop-up menu items are available only for certain types of tree nodes and each pop-
up menu item is enabled only when the user selects the appropriate type of tree node 
within mapping tree.

Disable UR Flag
This menu option disables the unsolicited reporting flags of all currently selected 
points. Section 6.5. Mapping editing features under Unsolicited reporting 
management provides more information.

Enable UR Flag
This menu option enables the unsolicited reporting flags of all currently selected 
points. Section 6.5. Mapping editing features under Unsolicited reporting 
management provides more information.

Remove Events
This menu item deletes event definitions from all currently selected points. Section 
6.5. Mapping editing features under Removing events provides more information.

Assign Class
Assign Class menu option is used to set the appropriate class to events produced by 
currently selected points. Section 6.5. Mapping editing features under Class 
assignment provides more information.
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7. IEC 60870-5-101

This chapter provides detailed description of the Protocol Mapping Tool features 
supporting the IEC 60870-5-101 protocol.

7.1. Protocol Mapping Tool Wizard
Fig. 7.1.-1 shows the Protocol Mapping Tool Wizard. First the user decides whether 
to create a new mapping, open an existing one or import a mapping from a different 
CAP project. It is also possible to delete mappings no longer needed.

A050092

Fig. 7.1.-1 The Protocol Mapping Tool Wizard

7.1.1. Creating a new mapping
The user needs to choose the desired format of measured values, control command 
type, addressing mode and, if continuous addressing mode was chosen, the base 
addresses for data categories.

Choosing the format of measured values
In the IEC 60870-5101 protocol, measured values can be transferred as normalized 
values (fraction of nominal value) or scaled integer values (original value multiplied 
by some scaling factor known to the slave and master station). The user can decide 
which format should be used (see Fig. 7.1.1.-1). The measurement format can later 
be changed individually.
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A050093

Fig. 7.1.1.-1 Choosing the format of measured values

Preserve Default Value Format

Measurements will be sent by using the format designed in patterns.

Set Normalized Value

Measurements will be sent by using the normalized format.

Set Scaled Integer Value

Measurements will be sent by using the scaled integer format.

Choosing the control command type
Two types of control commands are defined in the IEC 60870-5101 protocol. In 
Single Command the information about the desired position is encoded in the data 
frame by using only one bit. In Double Command, two bit representation is used for 
encoding the desired position. 

The user can decide what type should be used (see Fig. 7.1.1.-2).
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A050094

Fig. 7.1.1.-2 Choosing the control command type

Single and Double Commands

Both command types will be supported in the device.

Single Commands Only

Only single command type will be supported in the device.

Double Commands Only

Only double command type will be supported in the device.

Choosing the addressing mode
In fixed addressing convention all the data points will have default addresses. In this 
convention, the address map will be compatible with REC 523 releases prior to 
revision F.

If the master station does not accept some default addresses, continuous addressing 
convention can be used. In this convention all the data points in each data category 
(e.g. measurements) will be placed in continuous address order and each data point 
will be assigned a unique address to avoid overlapping. Changing the order of points 
in continuous addressing convention will always be possible. 

The master station profile should be checked to choose the right 
option. If you are not sure what convention is used, it is 
recommended to select both types of commands.
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The user can decide what type should be used (see Fig. 7.1.1.-3). 

A050095

Fig. 7.1.1.-3 Choosing the addressing mode

Choosing the point base addresses of data categories
Starting offsets can be adjusted for each ASDU type. For convenience, addresses 
can be given as decimal or hexadecimal values (depending on convention used by 
the master station). See Fig. 7.1.1.-4 and Fig. 7.1.1.-5.

Switching from fixed to continuous addressing convention is 
possible at any time (see Section 7.5.1. under "Set continuous 
address space"). However, the reverse operation is not allowed.
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A050096

Fig. 7.1.1.-4 Choosing the point base addresses of data categories (decimal 
values).

A050097

Fig. 7.1.1.-5 Choosing the point base addresses of data categories (hexadecimal 
values).
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7.2. Mapping tree
The structure of a mapping tree is fixed during the editing of the IEC 60870-5-101 
mapping (see Fig. 7.2.-1).

A050098

Fig. 7.2.-1 Data objects within the IEC 60870-5-101 mapping tree

The root node indicates the current addressing convention (fixed or continuous).

Data categories (ASDU types) are represented by branches with the following icon:

A050099

Tree nodes can contain both static and dynamic (event) information. It can be 
determined by a node icon set for a tree node representing a single point:

1. Node containing only static points

A050100

2. Node containing only events

A050101

3. Node containing both static points and events

A050102

Table 7.2.-1 Mapping tree point elements:
Address: 00002 (or 0002H if hexadecimal address format is selected)
Function: NOC3Low
Function revision: D
Description: Output TRIP
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If a mapping is read from a device with the Relay Download Tool, some points may 
have warning flags set. There are four warning flags:

� Invalid (the entry for a given point contains invalid information - point removed 
from data map)

� Corrected (the entry for a given point contained incorrect information and was 
corrected by the device during mapping parsing)

� No block (the device application does not have a function that contains this data 
- point removed from the data map)

� No object (the device application does have a function, but there is no such data 
item - point removed from the data map)

Tree nodes representing points with warning flags set have different background 
colors (see Fig. 7.2.-2):

� Purple background color indicates object flag set
� Light green background color indicates no block flag set
� Yellow background color indicates corrected flag set
� Red background color indicates incorrect flag set

A050103

Fig. 7.2.-2 Example of tree nodes indicating the active warning flags

When the user leaves the cursor over the tree node for a while, a tooltip window will 
be shown (see Fig. 7.2.-3).

A050104

Fig. 7.2.-3 Tooltips for IEC 60870-5-101 point

The following tooltip will be shown if the user leaves the cursor over an addressed 
data category, i.e. Measured values (M_ME) within the IEC 60870-5-101 mapping 
tree (see Fig. 7.2.-4).

A050105

Fig. 7.2.-4 Tooltip window for IEC 60870-5-101 data category

7.3. Mapping convention
IEC 60870-5-101 protocol supports the following mapping convention:

� Single point information (M_SP) nodes are used to represent the state of the 
digital input points (hardware or software).
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� Double point information (M_DP) nodes are used to represent state of two bit 
encodes binary points (hardware or software) such as breaker position.

� Measured values (M_ME) nodes are information objects used to represent 
hardware or software analog points. Their values can represent digitized signals 
or calculated values.

� Integrated totals (M_IT) represent the accumulated values. They can be 
accumulated pulses or transitions from hardware or software points.

� Bit strings in monitoring direction (M_BO) nodes represent values for reading 
that can be treated as bit masks.

� Strings in monitoring direction (M_SR) nodes represent strings of characters that 
can be read from the device.

� Single command (C_SC) nodes are used to make control commands on relays by 
using one bit convention for encoding desired position.

� Double command (C_DC) nodes are used to make control commands on relays 
by using two bit convention for encoding desired position.

� Set point commands (C_SE) nodes are used to set new value of analog output 
points.

� Bit strings in control direction (C_BO) nodes represent values for writing that can 
be treated as bit masks.

� Strings in control direction (C_SR) nodes represent strings of characters that can 
be written.

� Clock read command (C_CS) nodes represent devices current time of day and 
date.

7.4. Mapping editing features

Base address editing

The "Change base address" menu item (in Edit menu and pop-up menu) allows to 
change the base address for the selected data category. As a result, all the points 
within such a data category will be readdressed. The following dialog is used to enter 
a new base address (see Fig. 7.4.-1).

A050106

Fig. 7.4.-1 Base address editor

This option is available in the advanced mode and when the 
continuous addressing convention is selected.
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General interrogation assignment
The Assign General Interrogation Group menu item (in Edit menu and pop-up 
menu) allows to change the GI assignment flag value for the selected data points. As 
a result, all the selected points will or will not be assigned to general interrogation 
group. The following dialog is used to select GI assignment (see Fig. 7.4.-2).

A050107

Fig. 7.4.-2 GI assignment editor

Measurement value format change
The Change Measurement Value Format menu item (in Edit menu and pop-up 
menu) allows to change the measurement format for the selected data points. As a 
result, all the selected points will have selected measurement format (normalized or 
scaled). The following dialog is used to enter a new measurement format (see 
Fig. 7.4.-3).

A050108

Fig. 7.4.-3 Measurement value format editor

Data class (priority) assignment
The Change Data Class menu item (in Edit menu and pop-up menu) allows to 
change the data class (priority) for the selected data points. As a result, all the 
selected points will have selected priority (high or low). The following dialog is used 
to select a new priority (see Fig. 7.4.-4).

Description of the data class priorities:

High priority = Class 1

Low priority = Class 2



102

1MRS755277 
Protocol Mapping Tool
Operation Manual

CAP 505

A050109

Fig. 7.4.-4 Data class (priority) assignment editor

7.5. IEC 60870-5-101 specific menu items

7.5.1. Edit menu
Fig. 7.5.1.-1 shows the components of the Edit menu of the Protocol Mapping Tool 
for the IEC 60870-5-101 protocol.

A050110

Fig. 7.5.1.-1 Edit menu for IEC 60870-5-101 mapping

Set continuous address space
This menu option is used to switch to continuous addressing convention. 

The following dialog is used to set new base addresses for all data categories (see 
Fig. 7.5.1.-2).

This option is available in the advanced mode, when the fixed 
addressing convention is currently used.
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A050111

Fig. 7.5.1.-2 Selection dialog of base addresses

Assign General Interrogation Group
This menu item allows to change the GI assignment flag value for the selected data 
points. More information is provided in Section 7.4. under "General interrogation 
assignment".

Change Measurement Value Format
This menu item allows to change the measurement format for the selected data 
points. More information is provided in Section 7.4. under "Measurement value 
format change".

Change Data Class
This menu item allows to change the data class (priority) for the selected data points. 
More information is provided in Section 7.4. under "Data class (priority) 
assignment".

7.6. IEC 60870-5-101 specific pop-up menu
This section describes the IEC 60870-5-101 specific pop-up menu available for the 
mapping tree in the Protocol Mapping Tool.

Fig. 7.6.-1 shows the components of the pop-up menu shown for the mapping tree 
in the main window:

Continuous addressing convention is possible only when the reverse 
operation is not allowed.
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A050112

Fig. 7.6.-1 Pop-up menu for IEC 60870-5-101 mapping editing

Pop-up menu items are available only for certain types of tree nodes. Each pop-up 
menu item is enabled only when the user selects the appropriate type of tree node 
within the mapping tree.

Assign General Interrogation Group
This menu item allows to change the GI assignment flag value for the selected data 
points. More information is provided in Section 7.4. under "General interrogation 
assignment".

Change Data Class
This menu item allows to change the data class (priority) for the selected data points. 
More information is provided in Section 7.4. under "Data class (priority) 
assignment".

Change Measurement Value Format
This menu item allows to change the measurement format for the selected data 
points. More information is provided in Section 7.4. under "Measurement value 
format change".



1MRS755277 CAP 505

105

 
Protocol Mapping Tool
Operation Manual

8. Troubleshooting

This chapter provides answers to some frequently asked questions.

Some menu and pop-up items are disabled all the time. How to 
activate them?
Some menu and pop-up items are enabled only if the appropriate nodes are selected 
in the mapping tree (the pop-up menu's "Change base address" operation is enabled 
when a data category node is selected). 

The second reason why a menu/pop-up item is not available all the time is incorrect 
working mode. The Protocol Mapping Tool provides two working modes: basic and 
advanced. Some editing features can be used only in the advanced working mode. If 
you need more information about working modes, see Section 2.2.1. Working 
modes The switching between working modes is described in Section 4.2.1.3. 
Settings menu under Working Mode submenu. 

Why does the Protocol Mapping Tool allow saving an edited 
mapping in two types of files: mapping file and/or binary 
mapping file?
The mapping file is a text file containing complete information about a certain 
mapping, whereas the binary mapping file is a binary file having only a binary 
representation of mapping without additional information (i.e. information on the 
protocol mode required in Modbus dependent mappings for REM 54_ terminal is 
lost).

The binary mapping files are still in use because only such files can be downloaded 
into and uploaded from a terminal by the Relay Download Tool. 

How to create a binary mapping file for the Relay Download 
Tool?
The only way to create a binary file is to save the mapping file. The "Save binary 
file" attribute must be checked in the Save dialog (see Fig. 8.-1):
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save

Fig. 8.-1 Save mapping dialog 

Saving a mapping file is described in detail Section 4.2.2.5. Selecting address format 
(Hex/Decimal Points) under Saving an edited mapping.

What does it mean if "Cannot open file XXX.dat" messages are 
shown when loading or creating a mapping?
Such messages are shown when the Protocol Mapping Tool's resources are 
incomplete and the names of certain signals (maintained within loaded/created 
mapping) are unrecognized. In this case all unrecognized signals are described by 
the "Unknown signal" label. 

The problem has no influence on how a mapping is processed by the Protocol 
Mapping Tool.

What is the overlapping check operation and how does it work?
The overlapping check operation is provided only for Modbus mappings. It checks  
the data category address range within Modbus data types, to determine whether any 
data category begins at a memory address reserved by registers belonging to another 
data category. 
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The overlapping check is also capable of moving all points belonging to one of the 
data categories into the nearest unallocated location. Such an operation allows to 
avoid possible conflicts between points having the same Modbus address. The 
overlapping check is described in Section 5.4. Complex structures under 
Overlapping check. 

More information concerning the data category moving is available in Section 5.4. 
Complex structures under Base address editing. If you need more information about 
Modbus data types and categories, see Section 5.2. Mapping tree 
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9. Appendix

Export Conversion File format
The export file format is composed of columns (fields), which are separated by using 
a tabulator (as an unique character not used in signal descriptions).

Each point is exported as a single row entry. The number and name of the fields in 
the export file differ depending on the selected protocol. The following tables 
present the order and names of the fields used in the export file:

Table 3: Fields in the export file for IEC 60870-5-101:

An empty field (carrying no information) is always marked by a dash "-". 

Table 1: Fields in the export file for Modbus:
No. Modbus
1 Address
2 DB name
3 Explanation
4 Read only flag
5 SPA event names
6 Scaling factor
7 Value range
8 Unit

Table 2: Fields in the export file for DNP 3.0:
No. DNP 3.0
1 Address
2 DB name
3 Explanation
4 Event class
5 Unsolicited reporting flag
6 SPA event names
7 Scaling factor
8 Value range
9 Unit

No. IEC 60870-5-101
1 Address
2 DB name
3 Explanation
4 SPA Event class
5 Data class
6 GI assignment
7 Measurement value format
8 Scaling factor
9 Value range

10 Unit
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Address

Descriptive address format:
The format of this column depends on the provided protocol:

1. In case of a MODBUS Address=<Data Type> <Offset> (<Data Category>) 
where all the elements are separated by a space character and 
<Data Type> = CO | DI | IR | HR {CO-coils, DI-digital inputs, IR-input 
registers, HR-holding registers} 

<Offset> = {a decimal address within the data type}
e.g.
HR  0123  (PDE)
CO  1856  (SCH)
The content of pack registers/binary user-defined registers is addressed by using 
the binary position indicator.
e.g.
HR 0001 (PBD).01bit
HR 0764 (PRG).15bit  

<Data Category> = PDB | PDE | SCH | CTL | DGN | PRG | DDE  {PDB-process 
data basic, PDE-process data extend., SCH-slowly changing, CTL-control, 
DGN-diagnostics, PRG-pack registers, DDE-device data}

Example rows:
CO 0001 (PDB)    F014O001    PS1_14-D: Output 1 state   Y   F014E014/ F014E015    
-     0/1   -
HR 0002 (PDE)    F200I001    MECU3A-D: IL1    Y   -     MUL_100   0.0…20000.0   [A]
HR 2368 (PRG).09bit    F014I003    PS1_14-D: Input 3 state   Y   F014E004/ 
F014E005    -     0/1   -

2. In case of a DNP 3.00 Address = <Object Type> <Point> where all the elements 
are separated by a space character and
<Object Type> = BI | BO | AI | AO | CT | TM | AP | II {BI-binary input, BO-
binary output/control relay output block, AI-analog input, AO-analog output/
analog output block, CT-counter, TM-timers, AP-application, II-internal 
indication}
<Point>= {a decimal address within the data type identified by <Object Type>}
e.g.
BI  0127
AP  0001

Example rows:
BI 0007    F014O001    PS1_14-D: Output 1 state    1    Y    F014E014/F014E015     
-    0/1    -
AI 0001    F016O001    RTD1_16-D: Output 1 value    -    -    -    MUL_1000    
-10000.00000 …10000.00    [mA]
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3. In case of IEC 60870-5-101 Address = <ASDU type><Point> where all the 
elements are separated by a space character and 
<ASDU Type> = M_SP | M_DP | M_BO | M_ME | M_IT | M_SR | C_SC | 
C_DC | C_SE | C_BO | C_CS }
<Offset> = {decimal address within data type}
i.e.
M_IT  08762
M_SP 01856

Example rows:
M_SP 00000 F031O001 NOC3Low-D: Output START
F031E000/F031E001 1 0 -0..1-

M_ME 20226 F017I011 PSC1_17-C: Minimum battery-2
0 N - 18.0 ... 
33.0 [V]

SCADA address format:
Other offset format containing a word number and bit number is possible: 

<Offset>=<Word Number>^<Bit number>

where

<Word Number>=integer of (<Offset> / 16)

<Bit Number>=remainder of (<Offset> / 16)

<Word Number> and <Bit Number> are 0-based counters.

<Bit Number> matters only for binary signals.

e.g.

BI 0007^14

AP  0001

Example rows:
CO 0000^00    F014O001    PS1_14-D: Output 1 state   Y   F014E014/ F014E015    
-     0/1   -
HR 0001    F200I001    MECU3A-D: IL1    Y   -     MUL_100   0.0…20000.0   [A]
HR 2367^09   F014I003    PS1_14-D: Input 3 state   Y   F014E004/ F014E005    -     
0/1   -
BI 0000^07    F014O001    PS1_14-D: Output 1 state    1    Y    F014E014/
F014E015     -    0/1    -
AI 0001    F016O001    RTD1_16-D: Output 1 value    -    -    -    MUL_1000    
-10000.00000 …10000.00    [mA]

The format is selected in the Settings menu.
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DB name
DB name is the signal identifier in the terminal. When so-called shadow points are 
reported, the exported DB name will be composed of several identifiers separated by 
a backslash "/".

e.g.

BI 0183     F200E20/F200E21    MECU3A-D: IL2 low alarm reset    -    -    F200E20/
F200E21    -    0/1 

Explanation
Description of the signal.

SPA event names
This field provides information concerning SPA events, which are associated with 
an appropriate static point and are composed of event identifiers separated by a 
backslash "/".

Scaling factor
This field describes the conversion factor applied for the appropriate static point.

For MODBUS protocol:

MUL_1000_SIGNED, MUL_100_SIGNED, MUL_10_SIGNED, 
MUL_1_SIGNED, MUL_1000, MUL_100, MUL_10,NO_OPERATION, DIV_10, 
DIV_100, DIV_1000, DIV_10_SIGNED, DIV_100_SIGNED, 
DIV_1000_SIGNED

For DNP protocol:

MUL_1000, MUL_100, MUL_10, NO_OPERATION, DIV_10, DIV_100, 
DIV_1000

For IEC 60870-5-101 protocol:

FLOAT_UINT, FLOAT_SINT10, FLOAT_SINT100, FLOAT_SINT1000, 
FLOAT_SINT01, FLOAT_SINT001, FLOAT_SINT0001, 

Read only
Marks whether a static signal is writable. Field may be equal to:

Y - readable only

N - writable/readable
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Event class
The event class column describes the class set for events associated with an exported 
static signal.

The following single characters are used:

Unsolicited reporting
Marks whether unsolicited reporting is activated. Field may be equal to:

Y - unsolicited reporting activated

N - unsolicited reporting turned off

Value range
This column provides a value range of the exported static point. 

The field provides the real range of values possible for the static point (the value 
carried by a protocol may be different because the appropriate scaling factor is taken 
into account). 

In case of binary signals the value range is always equal to 0/1.

Unit
This field provides the unit of measure of the exported point.

The field matters for analog static points only.

Data class
This column describes the data class priority set for the exported signals.

The following values are allowed:

1 - High Priority

2 - Low Priority

General interrogation group
Shows the general interrogation group assignment of the exported static points. 
The field may be equal to:

0 - Not assigned to general interrogation

1 - Assigned to general interrogation

- - Undetermined (i.e. no static signal defined for this protocol point)

Table 4: Event class field values:
Value in event class field Explanation

1 Class 1
2 Class 2
3 Class 3
N Not assigned
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Measurement value format
Shows the scaling format of M_ME and C_SE analog values. 
The field may be equal to:

N - Normalized (M_ME_NA, C_SE_NA)

S - Scaled integer (M_ME_NB, C_SE_NB)

For other data types, the field is always equal to "-".

Containers (such as pack registers and user-defined registers used in 
MODBUS) are not specified, but their content is listed instead. 
Contained points are described as common signals having 
appropriate bit position within the container and its address.
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